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1 Overview

1.1 Application and function description

This document is intended as a supplement to the NETLink”
product line manuals.

Many visualization manufacturers support the TCP/IP protocol
‘RFC1006’ also known as ‘ISO on top of TCP’ to be able to com-
municate with §7-300/S7-400 systems, for example.

RECTO06 £ 150 an top of TCP/IP

o In:ﬂ]

Autamatisierungsgeral

If this ‘RFC1006’ function is activated for example in the NET-
Link® PRO, explicit adaptations must be made to the software
products. This manual describes step by step the basic settings
of a small selection of visualization solutions for transferring
data via this communication path.

In firmware versions from 2.3 of the NETLink ® PRO family
adapters the "RFC1006" function is always active.

It is assumed that the reader is familiar with the development
environment of the software solutions mentioned in this
document, as only the points specific to the connection are de-
scribed

More extensive support with commissioning and parameteriza-
tion of the various SCADA-, HMI/OPC server systems is avail-
able directly from the manufacturers in question.

At this point is not described how a Internet teleservice via
VPN and port forwarding is implemented with a NETLink"
Ethernet gateway.

1l 1.2 Information in the figures

Please pay attention to . Many of the figures in this document contain settings and di-

Zw information in the rections for use marked or highlighted in red.
qures
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2 RFC 1006 Activation via the Web Interface

The examples described here are based on NETLink models
with firmware versions less than V2.3 (e.g. NETLink ® PRO).
Prior to the use with this device the RFC 1006 functionality has
to be set manually.

A detailed description is also given in the accordingly manual!
We generally recommend upgrading your NETLink® products
with the last firmware version, so you can always use the latest
features.

2.1 Requirements

The NETLink® Ethernet gateway is connected to the PC via a
network card. One of the SCADA/OPC server programs de-
scribed below is also installed on this PC. The Webinterface
function must not be deactivated. It is accessed via one of the
installed Internet browsers (for example, Mozilla Firefox, Op-
era, Konqueror, or Internet Explorer).

You do not need to install any additional drivers for the NET-
Link®.

The applications described here were performed on the Win-
dow XP operating system with service package 2 and 3.

2.2 Adapting the configuration side

As soon as the Web interface is opened by entering the rele-
vant URL ‘http://<ip address>’, the link to “Configuration” opens.
As soon as you have answered the security query, you can write
to all parameters.

ﬁ From version 2.3 there is a text field: "RFC mode is always acti-
vated". In this case, you can skip this section.

The ‘RFC 1006 interface ON/OFF’ option is activated by entering
“ON” and confirming with the “OK” button (see Fig.)

In the next window, the settings are displayed again and must
be confirmed with “OK” before they are finally transferred to
the NETLink® device.

The following screenshots were created with NETLink® PRO.
The settings can also be made in all NETLink® Ethernet vari-
ants.

NETLink® PRO family Application Examples 7
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Rebooting can take up to

Configuration menu in NETLink® PRO:

elmholz

compatible with you
Configuration Observe Variables

NETLink PRO Configuration

Device specific parameters

Device name | Martin |

TCP parameters

Static TP address |192.1 63,438 | Static parameters are used if DHCP is switched off

Static subnet mask |255.255.D.D | Static parameters are used if DHCP is switched off

Static gateway |D.D.D.D | Static parameters are used if DHCP is switched off
Alternative NETLink Port |???? | Don't use well-known ports less than 1024 (Default port is 7777)
DHCP ON/OFF |oFF |

DHCP Timeout (in seconds) |DHCP is disabled |

Web interface ON/OFF [on |

RFC 1006 / S7T-TCP parameters

P
RFC 1006 interface ON/OFF QON) | The following parameters are used if EFC 1006 is switched on
- Bus autobaud ON/OFF [on |
- Own station address [0 |
. ) ) Baud rate , The bus parameters are used i
- Stored bus parameters (KBit/s) HSA autobaud detection 15 switched off

Tdot it 05 |Tn
Min.
Mix Tsdr [ o

S T S C—
GapFactor 5 |Rety
- Rack/Slot mode ON/OFF |oFF |

- Fix destination address for R/S mode |2 | This parameter is only necessary if
raclkslot mode 15 switched on

Password settings

New password [snsee |

Retype new password [enene |

=)

’ Swstern Reset ] ’ Cancel

After the new parameterization data have been stored, the

15 seconds. NETLink® PRO is restarted to activate the new configuration.

NETLink® PRO family Application Examples




3 Systeme Helmholz OPC-Server V4.0.6.4908

The following steps must be performed in the described se-
quence (Version July 2011):

3.1 Configuration of the communication partner

Start the “Configuration S7-OPC Server” program module via
Start/Programs/Systeme Helmholz/S7-OPC-Server:

e Select tab card “Devices”.
¢ In this example, click device 0 and then select “S7-TCP/IP”
from the pull-down menu.

o Systeme Helmholz S7/55-OPC-Server-Configuration

Connectiofks | Devices | Options OPC-Server | Options Program

@ Mot active v

5 Mot supported

Oveviee 1 Mot active

Device 2  |57-MPI
® perca S7-NETLink lite:
O Device 3 S7-NETLink PRO Family
S7-NETLink USE
Obevice 4 [57-CIF
=50

O Device 5 No settings available.
O Device 6 57-PPI

. 95-A5511
Obevice? |55 7cpi1p

O Device 8 Mot active

O Device 9 Mot active
O Device 10 | Mot active

ODevice 11 [Not active

JRE

3

O Device 12 ant active v

O Device 13 Mot active v
ODevice 14 | Mot active v
O Device 15 Mot active v

[ OK ] [ Cancel ] [ Apply ] [ Help (F1)

¢ Go to the tab “Connections” in the right sub window.
e Click ,Change...” to create a new connection.

o Systeme Helmholz S7/55-OPC-Server-Configuration

Connections \ Devices | Options OPC-Server | Options Program

@bevieso  [s7-TcRpIP v [ cpitp_ Connections [gpC-server

O Device 1 lNUt active v PLCno = IP Address Rack Slot Type
O Device 2 Mot active v
O Device 3 l Mot active v

<

O Device 4 Mot active Connection no.: 0 @
O Device 5 Not active | PLC no.: [—i
O Device 6 lNot active

1P-Address 192.168.4.197
O Device 8 [Not active Rack: ‘

O Device 9 Not active Slat: 2
Opbevice 10 |Notactive | Type: 57-300/400 v

ODevice 11 [Not active

O Device 12 antactive v w [ s ] IHBID(H) ]

O Device 13 Mot active v
ODevice 14 | Mot active v
O Device 15 [Not active v [ Change... D[ Delete ] adjust columns

<

O Device 7 [Nut active

BB RE

3

I OK I [ Cancel ] [ Apply ] [ Help {(F1) ]

It opens a new connection window

NETLink® PRO family Application Examples 9



10

The PLC no. and Rack in this example is not relevant
Enter the NETLink® address in the IP address field
Enter the MPI address of the connected PLC in “Slot”
Finally set the type of PLC you are working with.
Close the window by clicking “OK”.

o Systeme Helmholz S7/55-OPC-Server-Configuration

| Connections ‘ Devices | Options OPC-Server | Options Program

@Deviced  |S57-TCRIIP v | TCP{IP Jm OPC-Server

O Device 1 lNUt active v PLCno = IP Address Rack Slot Type

O Device 2 Not active I 1) 192,168.4.197 1] 2 57-300/400
O Device 3 Not active v
O Device 4 Mot active

O Device 5 Not active |
O Device 6 Mot active

O Device 7 Mot active

£[|€

<

il

O Device 8 Mot active

O Device 9 Mot active
O Device 10 | Mot active

ODevice 11 [Not active

L€

< |

O Device 12 ant active v

ODevice 13 Mot active v
O Device 14 | Mot active v
O Device 15 [Not active vl I Change... I [ Delete Adjust columns

[ OK ] [ Cancel ( Apply m Help (F1)

Complete your connection settings with “Apply”

Next, select the main tab “Connections”
e Click the Button “Scan”.

o Systeme Helmholz S7/55-OPC-Server-Configuration

Devices | Options OPC-Server | Options Program
Device PLCno RS Connectionname Primary connection  Symbols

Connections for device number

Device number: ‘ | <}
e—

) [ Cancel ] [ Help (F1) ] Tes
[ OK ][ Cancel ][ Apply ][ Help {F1) ]

Enter the configured device number (possible O to 15). In this
example -> 0

e Confirm with “OK”

The connection to the adapter should be established and dis-
played.
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Choose the CPU address
as PLC-number to
prevent duplicates

e The CPU can be determined with “Test” (this feature is op-
tional and must not be executed in mandatory).

Connections ‘Devices\ Options OPC-Server | Options Program
Device PLCno R/S Connectionname Primary connection Symbols
o 0 No
=D b=
——
OPC Client
[ OK ] [ Cancel ] [ Apply ] [ Help (F1) ]

e The connection test was successful and can be confirmed
with “OK”.

The OPC server is now fully configured for a NETLink®”to PLC
connection.

If you want to set up multiple connections within a device, the
“PLC no.” has to be unique for each connection. These num-
bers must be different.

o Systeme Helmholz S7/55-OPC-Server-Configuration

| Connections ‘ Devices | Options OPC-Server | Options Program
@ Deviced | S7-TCRIP v] | |[rcpip | Connections [opc-server
O Device 1 lNUl‘ active v no IP Address Rack Slot Type
Obevicez | ot active - | 2 192.168.4.197 0 2 57-300/400
3 192.168.4.197 1) 3 57-300/400
O Device 3 Noiacﬂte | 6 192.168.4.197 a 6 57-300/400
O Device 4 Mot active v
O Device 5 Not active v
O Device 6 Mot active v
ODevice7 | Not active v
O Device 8 Mot active v
O Device 9 Mot active v
O Device 10 Mot active v
O Device 11 Mot active ;‘
Obevice 12 |Notactive v
O Device 13 Mot active v
O Device 14| Not active v/
ODevice 15 Mot active | vv Change Delete
[ OK ] [ Cancel ] [ Apply ] [ Help (F1)

3.2 Setting up the OPC Toolbox demo client

The following steps are provided as an example only and are
not obligatory for customer applications. They serve as a visual
check whether data exchange is taking place.

Start program module “OPC Toolbox demo client” with
Start/Programs/Systeme Helmholz/S7-OPC-Server. The various tab
cards are displayed below.

The “OPC Servers" field opens first:

NETLink® PRO family Application Examples 11



12

e the tree structure can be open by clicking the plus sign in
front of “Local”

IFF Softing OPC Toolbox Demo Client [9(=1E3]
File Edit Session View Help

] = =] 5] X a

New Open Save Stop  Connect Start |__|

[=] DataAccess V1
[E] DataAccess V2
[E DatadccessV3
[E Alarms and Events

al
+
+
+
+

+ Remote
+- 4 Manual
URL: [ Add Server

OPC Servers l D& BrowseJ D& IlemsJ AE Browsel AE Evenlsl AE Conditions] Errors

Ready

e open “Data Access V3” in a similar manner

e open “Helmholz S7/S5 OPC Server” similarly

Double-click “Helmholz.OPc.S7.DA.1”

The “group” opens in the left field. The green circle indicates
that the connection has been started.

Now switch to the “DA Browse” tab card.

e open“opcda://Helmholz.OPC.S7.DA.1/{...” in the tree structure

o A device is displayed when it has been found (in this case
“0.07).

e On opening the device, the data access objects are searched
from the CPU and then listed.

e Transfer the selected items into the left column by double
clicking (multiple selections possible).

IFF Softing OPC Toolbox Demo Client 9((=1E3]
File Edit Session View Help
0O = =] 5] X K a
New Open Save | Properties Stop  Connect  Start [Cwite ]
=@ Data Access =@ opcda:///Helmholz.0PC.57.DA.1 ASCSFBBE 7-0462-4FCB-99CC-BEEOD4BOBEDE}
-I-@ opcda:/{{Helmholz,OPC.57.DA. 1{{8CSFBBB7-0A6: + B _System
=@ group - [ 0.0
© 0.0#E P
© 0.0#A © State
© 0.0#M © ConnectionType
© WiteComplete
@ VersionPLC
© VersionPGAS
© ‘WriteltemCount
© Connected
= E
- A
- M
=T
-2z
- LAS
= LD
< 5 | OPCServers DA Browse IDA IlemsJ AE BrowseJ AE Evenls] AE CondiliunsJ_E_rEI_s_J
Ready

NETLink® PRO family Application Examples
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Now switch to the “DA Items” tab card.

e The connection quality status is displayed in the “Quality”
column

o Currently, only the permissible name range elements are dis-
played under "Value".

r Softing OPC Toolbox Demo Client

CBX

File Edit Session View Help
D & H B | x| X @ ‘
New Open Save Properties Delete Stop  Connect Start ot
= @ Data Acgess - L || ltem | Value I Quality | TimeStamp [ Result
cl ? gc a:/{Helmholz.OPC.57.DA. 1/{8CSFBBE7-0A6: | (50 nar 128 G000 16:34:27.626
& .08 © 0.08M 256 600D 16:34:27.626
0.0} ® 0.08M 256 GOOD 16:46:10.885
@® 0.0#M
< \ 3
< 5 | OPC Sevversl DA Browse DA Items |AE Bmwse[ AE Evenlsl AE Donditions[ Errors
Ready A

e Every item can be edited by selecting it and then clicking the
“Properties” button.

Softing OPC Demo Client - Properties [x]

o

g4
oK Apply

Reset
Item I
Item ID: IU.U/MBU[U‘.Z} Native Datatype:  |UI2 Server Handle: IW
Req. Datatype: [EMPTY _!J Access Rights: read Client Handle: ,m

Engineering Units:  |no

Deadband:

5 —

Item Path: |

I

e The changes are adopted with “Apply” and “OK”.

Further examples of the syntax of various items:

r Softing OPC Toolbox Demo Client

CEX

File Edit Session View Help
D & H & X | X @ ‘
New Open Save | Propertties | Delete Stop  Connect Start | 7
=4 Data Access Item [ Value [ Qualt [ Ti
d ; ty TimeStamp | Result | Server
=@ gce'“‘m'z'opc'sm‘“ © QOMWOWORD 4145 GOOD 03:01:27.5% opeda//l.
@ o OWORD: © 0.0/M3.2B00L 0 GO0D 08:28:19.609 opeda:///..
@ UIU/M3 Z:BOOL @ 0.0/DB1.DBW2DATE  2011-25 GOOD 08:39:27.541 opcda://i.
® 0.0j081 DevZiDATE || © DOMBOD.2] [02](16,49,0)  GOOD 03:01:27.535 opedaidil.
@ 0.0/MB0[D..2] @® 0.0/75 Oms GOOD 08:58:03.447 opeda://i.
® 0.0/Ts © 0.0/DB1DBWEWD... 30 GOOD 08:58:38.009 opedai/if..
@ 0.0{DB1.DBW6:WORD
<) >
< b OPC Serversl DA Browse DA ltems | AE Blowsel AE Events I AE Condilinnsl Errors
Ready AU
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4  INAT-OPC-Server (INAT GmbH)

The following steps must be performed in the described se-
quence (status May 2008):

41  Configuring the INAT OPC server

The following dialog box opens when you select “Configura-
tion->AccessPathDefinition” from the menu:

B2 lelRlw s Ax] @ EEE Sl &

M Access Path Definitionen - INAT OPC-Server
Konfiguration  Abbruch Ok
Yerbindungsname Tyup Prot Intervall Akt Ziel

|50 on TCP 57 H2.168.4.38
{public 150 on TCP 57 100 Client  192.168.4.38

0102 e
<0202>, ‘whrite

{public-500 15000 TCP 57 500 Client 192162438 |so <0100 <0202, Write
public-1000 150 on TCP 57 1000 Client  192168.4.38  |s0 <01003<0202>, Write
Hklaus-79 150 on TCP 57 100 Client 192163473 |so <0100y <0025, write
cpulc 150 on TCP 57 1an Client 192168438 [s0 <000 <00C, Write
A00er 15000 TCP 57 10 Client 192162438 |so <0100 <0203, Write

400er-2 150 on TCP 57 o Client  1927168.4.38  [z0 <0100:< 02023 Write
A00er-4 150 on TCP 57 0 Client  192168.4.38  |so <0005 <0204, write
4005 150 on TCP 57 1} Client 192168438 |50 <0005 <0205, Write
A00er-E 15000 TCP 57 10 Client 192162438 |so <0100 <0206, Write
A400er-7 150 on TCP 57 o Client  1927168.4.38  [z0 <0100:< 0207 Write
H5-2dp 150 on TCP 57 0 Client  192168.4.38  |so <0100y <0203, write
cpud1 717 150 on TCP 57 0 Client  192168.4.38 |50 <0005 <0217, Write

ol o

A new connection is generated via menu “Configuration->New”
in dialog box “Access Path Definition”.

The following dialog box opens.

Neue ¥erbindung ['5_(|

Marme: Jtesd oK |
At der Verbindung )~ Pratokoliyp - | e
Wl 55 ——J
& ICPAP & 57 Hilfe

" Modbus

" metlINEAnetLINK Plus @r
R

" pLCS

" MELSECO

" Send/Receive

When you have confirmed the new connection with the OK
button, you can set the parameters in the subsequent dialog
box:

NETLink® PRO family Application Examples



The most important entries are:

e The IP address of the target station
e Connection properties RFC1006

TCPAIP Parameter bearbeiten [g
Werbindung
ak.
Marne: ]4009[-5

Abbiuch
Pratokolltyp: {5?
Hife
W Zuklisches Lesen einechalten  Leseintervall [ms]: ll] _;__]

¥ Schreben in die SPS erlaubt
reiben b glﬂ!l
F g

I Lese

I~ Fetch on Event

Zielstation: [P-&dresse oder Mame
[192168.4.38

¥ High Performance Pratokall

1SO-on-TCP Parameter, { REC1006 )

LT S EL R 150-0n-TCF [RFC1005) Yerbindun
T -on- igspararmeter 1
" KeinHeader (* 5PSHeader @ BFC 1006
F i Leser ,— —Lokaler TSAP wert Hex whet ASCI
150-0n-TCP Abbruch
F [RFC1008) ) » || Eigenertsap  [o00 N
— L Hilfe
1~ Femner TS&P
fiir Leser 10205 ]“ I~ Routing
¥ Lebenstelegramme W Daten-Lebenstelegramme und Schreiben
- I
W — e
srbindungsaufbau Fratakall 05 = address of PLC
= pAktiv " TCP [gesichert]
" Passiv " UDF [ungesichert
Spezielle Einstellungen
W Leseoptimisrung |12 Butes fir neuen Block

3

The RFC1006 setting is configured via the “ISO-on-TCP” but-

ton.

4.2

INAT-OPC Client

Select the OPC Server.

Once the server is configured, you can access the data of the
controller via the OPC Client.

You can select the OPC server from which the configured data
will be fetched via menu item “File->New".

#f Fie - s
D= R B[@

_[o/%)

40 400er-3 {Ackual Rate:
F@ 400er-Z (Ackual Rate;

@ 400er-7 (Actual Rate: 100

Ewvenk

Item added - - {Item) dbi9.d
Itemn added - - (Item) dbz1.d
Item added - - {Trem) dbz1.dl
Item added - - {Item) dbz1.d

Ry r - et Select an OPC Server

OPC Server Prog 1D:

Located Servers:

| TtemID | Sub Yalue | Sub Qualit I Sub Upc
g| Bad - Mot conn,., 1
[INAT TeplpH1 OPC Server
Cancel
Browse...

Archestid, DASSIDirect
Helmholz.OPC.57.0A.1
IMAT TeplpH1 0P WET
OPC.SimaticHMI.HmiR Trn

HMode Mame [Optional):

Softing OPCT aolboxDemo_Se

2
Time A

10071

JUHEFEN
10:07:1
10071

Itern added - - (Item) MBO
Item added - - {Trem) mb0
Item added - - {Item) mb0

Groun add - - (Groun best #(Tterm) 0

10:07:1 -
10:07:1
10:07:1-
10:08:4 ..

NETLink® PRO family Application Examples
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Configuring visualization data

o First of all, create a "Group"

e Menu “Group->Add Group...”

Add New Group

Group Mame: |test-group] Sl
|Ipdate Bate [mSec) |1000
Uiz | U r Update Fate
% Deadband: ‘1 W Allow Timeout

X

W Active

=

Advize: IICDnneclionPDint [Few 2.0) L]

Then select menu “Item->Add Item...”

Important! In field “Access Path” you must enter the name of

the connection exactly as designated in the OPC server

fdd New OPC [tem
Itemns to be Added

For "Item Name" enter the variable from the SPC

Finally press button “Add Item” and then “OK”

Altributes
oK

i

Access Patht [400er-6

Cancel
Item Mame: ’MB—‘
d Add ltem
Achve: W .
Datatype: [y EMPTY = alidate
e Itemn Properties
Datatype: | Native v] B Filter: { Aocess | &l lkems 5 ‘
+- Root (Node: <Local=) Ttem Leaf J

‘f'ou can add items using this dialog.  Click on validate items if you wish to check wour
iterns against the zerver before adding thern. R esults will be dizplayed from thiz action.

NETLink® PRO family Application Examples



5 Indusoft Web Studio V7.0

The following steps must be performed in the described se-
quence (status August 2011). The user should be familiar with
IWS or at least have the “Getting Started” guide and the Indu-
soft-driver specs “SIETH” at hand.

5.1 Configuring the Indusoft communication driver

Choose the tab ,Comm* in , Project Explorer”, then right-click
on “Drivers” and choose “Add/Remove drivers”:

‘) DE-% 0 -O0|@ ¢ | sraphicsToos InduSoft Web Studio - = x
~ Home | Wiew | Insert  Project Graphics Help
E V' Project Explorer Grid Zoom ¥ Language (m|m|
V| Database Spy V| Status Bar AaFont 0O
Restore ) Windows...
Default |¥] Output Window ] Zoom Box 5 e
ShowfHide: Zoom Options Window
roject Explorer. 2 X
= /s Project: test.APP
K
;. orC | AddjRemove drivers [
W), oPCUR——————
@), OPCXi
|, TCRiIP
. DDE
@Giobal Mgraphics FTasks
Database Spy 2 X Output 2 x
Tag/Expression Value Quality  Continuous ~ S
(@] v
< < » » DB1 DB2 DB3, DB4 T ] Log, XRef.
Insert/Remove new Drivers (communication protocols) Engineering Only| CAP|NUM| SCRLID:2 [ %: 561, v: 404 |W:32,H:30 Tag count | ;3

Pick the “SIETH” driver out and add it by clicking “Select>"and
confirm with “OK”:

g

Available drivers:
DLL Description » Help
Press , Help” before you SBUS 5414, P8 Protocol - PCD2 [Beta]
I he dri . d SCaN BarCode Scanner [1.02]
select the driver in order SFMS  SIEMENS - ProfBus FMS compatible equipment [v2.06]
to open the corres ond- SIEME SIEMENS, 57 PLC communicating via Serial interface (CE) [+10.6]
. P . P SIETH SIEMENS, 57 PLC communicating via an Industrial Ethernet interface [CE) [+10.6]
mg driver manual. SIPPI SIEMENS, 57-200 PLC communicating via PPl interface (CE) [v10.6]
SISP USIMINAS - Dedicated equipment [1.10]
SIST Sistema, CP-3000 [Mono and Multiprocessor] [+1.14] hs —
< 3| [Select> ]
Selected drivers:
DLL Description
< >
{ 0K ) [ Cancel ]
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e In the ,Project Explorer”, tab ,Comm* right-click on the
driver “SIETH” and from the context menu choose “Set-
tings”:

InduSoft Web Studio

l Insert

) OPCXi | Settings |
L TeRP ]degp
. DDE

Wnldlblbll DB1, DB2, DB3, wu.m
I

L

Under “Serial Encapsulation” choose “TCP/IP” and under “IP
Address” enter the IP address of the NETLink. Everything else
will be left default:

& SIETH:

Serial Encapsulation: ‘

Network
IP Address: (192.168.4.49 |
Port Number: I 10001 |
Status Tag: l |

[] Server Mode

1 - Signed / 0 - Unsigned: String 1:
Lo I |

Initial Connection ID (0 to 7): String 2:
C | |

" | 0K Cancel |
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5.2  Setting up values to visualize

In the tree of the “Project Explorer” under “Drivers” -> “SIETH”
you can find a “Main Driver Sheet”. Double-click either this or
any other driver sheet:

(@A\\OE-%E-000 ) InduSoft Web Studio - SIETH - MAIN DRIVER
Home View Insert Project Help
& Cut = ©Run ’ # Dowinload = z ﬂ B, Import Wizard , 2
23 Copy W= O stop O Run . L‘BConvert Resolution F
Paste Tasks Connect - Tasks Database LogWin = VYerify Global
& Find ) stop Spy ¥4 Register Controls Replace S&F
Clipboard Local Management [ Remote Management s Tools s
Project Explorer ax [®] SIETH - MAIN DRIVER SHEET X
= /A Project: test.APP T
=), Drivers escription: ‘
= ). SIETH | MAIN DRIVER SHEET |
<”|®] MAIN DRIVER SHEET Disable:
|, OPC l ‘
@), OPCUA
@), OPCXi Read Completed: Read Status:
| TCP{IP l ‘ l l
)

. DDE O i
‘Wite Completed: Wiite Status: Mawl ]
| | |

Tag Name Station /0 Address

On this “Driver Sheet” you have to configure any values you
choose to visualize.

o After double-clicking the first empty cell in the column “Tag
Name” a dialog window opens, in which to choose the tag to
specify. In this example the tag is called “Mbyte”:

M Object Finder X

Selection: IMthe ‘ dex] || Membe
= Tags Name Description
= [ B < L
I Boolean
L~ Integer
[ ed
String
i Class
® B system
< >
Source Status
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e Enter the IP address of the adapter, the rack number and the
slot (the PLCs MPI address) under the column “Station” using

this format:

<IP address> : <Rack> : <Slot>

DS -®LE-00e

Home Yiew Insert

Paste
&9 Find

Clipboard Local Management ™

Project Explorer

= ‘s Project: test.APP
(=)}, Drivers
=, SIETH
[] MAIN DRIVER SHEET
|, OPC
|, OPCUA
@), OPCXi
|, TCPiIP
|, DDE

& Cut @Run
23 Copy G‘L] O stop

Project Help

’ # Dovnload  [= z ﬁ
3 Run -
Connect

Tasks Database LogWin
) stop Spy
Remote Management IF]

ax [®] SIETH - MAIN DRIVER SHEET X

InduSoft Web Studio - SIETH - MAIN DRIVER SHEET

gﬁ Import Wizard ( ’ 3¢ Replace
Ld Convert Resolution 3@ Remove unu
Verlfy Global
¥Register Controls || peplace 3% Reset tags ¢
Tools iFl

Description:

| MAIN DRIVER SHEET|

Disable:

Read Completed: Read Status:

‘wite Completed: ‘ ‘Wwrite Status:

Tag Name
1| Mbyte 192168

*

*

Station 1i0 Address

.4.199:0:2 | Reat

Reat

P

e Adjacent enter the memory address of the variable you want
to access on the PLC under the column “I/O Address”
(for further information please consult the “SIETH” driver

InduSoft Web Studio - SIETH - MAIN DRIVER SHEET

Project Help
’ # Dowinload L‘ z ﬁ Ei Import Wizard L ' 3¢ Replace
ORun & L(jconvert Resolution 4 Remove unt
Connect Tasks Database LogWin Verify Global
Spy ¥|Register Controls || Replace S Reset tags ¢
Remote Management 15 Tools 5

manual):
NES-REH-000 -
Home View Insert
& Cut
53 Copy

Paste

&% Find

Clipboard Local Management =

Project Explorer

= /s Project: test.APP
(=)}, Drivers
=), SIETH
[®] MAIN DRIVER SHEET

|, OPC
|, OPCUA
|, OPCXi
1}
1

B8

| TCR{IP
. DDE

X [®] SIETH - MAIN DRIVER SHEET X

Description:

‘ MAIN DRIVER SHEET

Disable:

Read Completed: Read Status:

[ ][

[
o1

‘Wwrite Completed: ‘ Write Status:

Ny

Tag Name

Station 1i0 Address

1| Mhyte 192.168.4.199:0:2 |mBO Rea
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e Important for §7-200 users!

The V registers of the S7-200 can be read by stating the DB1

registers. (For further information please consult the “SEITH”

driver manual):

Jj'ifﬁjvgﬁo :

Home: Wiew Insert Project

% cut =] ©Rrun ’ # Download  [=— z ﬂ r B8 1mport wizard
23 Copy @ O Stop ©ORrun
) Stop

Paste T

asks Connect .

InduSoft Web Studio - SIETH - MAIN DRIVER SHEET

’ 3¢ Replace

Help

[ Convert Resolution

H& Remove unusec
Tasks Database LogWin = Verify Global
& Find Spy ¥4 Register Controls Replace Gt Reset tags datz
Clipboard Local Management ™ Remote Management M Tools 5 Ta
Project Explorer 2 [®] SIETH - MAIN DRIVER SHEET X
= /s Project: test.APP )
a Drivers Description:
=), SETH | MAIN DRIVER SHEET
[=] maIN DRIVER SHEET Disable:
). OPC [
#- ), OPCUA L
@), OPCXi Read Completed: Read Status:
|, TCRIP [
|. DDE - O
‘white Completed: - Wiite Status: ‘
Tag Name Station /0 Address AC
1 Mhyte 192.168.4.199:0:2 DB1.DBO Read+
*; Read+
bl Read+
i Read+V
* Rear+it

e Save the “Driver-Sheet” and run the application. The value

contained in flag byte O (VBO in a $7-200) will be saved and
displayed in the tag “Mbyte”.

NETLink® PRO family Application Examples
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6 InTouch V9.5 (Wonderware GmbH)

(System Management Console 2.0 Version 5.1)

The following steps must be performed in the described se-
quence (status July 2007):

6.1  Starting the System Management Console

"Start->Programs->Wonderware->System Management Console"

% SMC - [ArchestrA System Management Console (PC39)\DAServer Manager\Default Group\.ocalMrchestrA.DASSIDirect. 1\Configuration\New. ... |;||Erz|

Datei  Akkion  Ansicht 7
& = m X 2
ﬂﬁ Archestra System Management Cansole (PC39) . L
p DAServer Manager !gﬂ Node Type: S7Cp Delimiter: .
% Default Group
=l @ Lacal METLink_S7Cp_000 Parameters ]Device Groups I Device Items 1
=k @ Archestra, DASSIDIrect. 1 =
= ;ﬁ Ot igar aton Processar Type: 187 FLC =
i i z - 57 Connection—MNETLink PRO IP-Adresse ——
: eintragen i~ Remate TSAP-
- [IE] Log Vieper Metwork Address: 11 92.168.4.38 Remate Rack No 0 .
i~ Local TS&P- i Remote Slat Mo: E cPu
mit rechter Maustaste MEEtreass
"Sapeer aktivieren” 1 '] |0 '] Connection Resource: 3 v] eintragen
= PLC Connectivity
I~ Werify PLC connectivity when na item is subscribed.
Frequency in seconds to verify the PLC connectivity (=it} seconds
Fieply Timesout: 15000 s
ConnectionTimeaut: ;30000 ms
i~ &larms & Events
{* Disable al
" Enable alarms
(" Enable events
il T il
Time difference between the PLC time and
the UTC
i = 1 [i v
) | ¥

6.2 Configuring the Device Group

Enter Device Group (later the NETLink® will be addressed with
this name from the WW(Client)

% SMC - [ArchestrA System Management Console (PC39)\DAServer Manager\Default Groupll.ocal\irchestrA.DASS

Datei  Akkion  Ansicht 2
e = @ X 2
ﬂ ArchestrA System Management Cansols (PC39) Qﬁ

=] @ DéServer Manager —
= % Default Group

Node Type: S7Cp Delimiter: .

=5 Local METLink_S7p_000 Parameters  Device Groups | Device Items ]
= 48, Archestrs, DASSIDirect. 1
= & cConfiguration | Mame | Update Inkerval (ms)
=] /g Mew_PorkCps?_METLink Metlink-Group 1000

& METLink_57Cp_000
i £ Diagnostics
[+ @ Log Viewer
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6.3 Configuring the Wonderware Client

"Start -> Programs -> Wonderware Factory Suite -> Common->
WWClient" to establish connection

Node: " _T_J

Application: ]DASSIDirect _:_J

Topic: 1Nellink-ﬁruup j
“In der SMC konfigurierte DeviceGroup

— Connection Type-
" DDE |07 10T - Thread

Create Done

If the connection has been set correctly, the following display
opens:

' Wonderware Client

Fil= Script  Connections  kem  Help - | B X
10T DaSSIDirectNetink-Group 000368290

=

Configuring the item

— Connections ’
Register

DASS | DirectMetink-Group  0x0

Advise
Unadvise
Fequest
Unregister
Item- | Poke

@ v|  [stina +] AdviseEx

[ Value: UnadviseE

Ll e

Done

If the Item configuration is correct and the SIDirect DAServer
has been activated, the configured “Ifem” is updated in the
“Wonderware Client” window.

+ Wonderware Client

File Script  Connections  Item  Help - 8 %

10T DASSIDirectNetink-Group Ox003bE3230 15
210 131B14.0718  07/30/2007 0x00c0
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7 KEPserverEx V5.4.135.0 (KEPware Inc.)

The following steps must be performed in the described se-
quence (status December 2010):

7.1 Configuring KEPserverEx

Start program module KEPServerEx, create a new project or
right-click in the demo project and select “New Channel”.

|@ KEPServerEX - Runtime

BEX]

File Edit View Tools Runtime Help

NEd % ry L ) . o E
+ EP Charnel Tag Mame Addreszs Diata Type Scan Rate Scaling
+ iij Data Type Examples
+- &0 Simulation Examples

<] 2]

Date | Time | Source | Event
0 26.11.2010 17.08:24 KEPSerelx\R... FEepware Commurications Server 5.4
o 26.11.2000 17.08:25 KEPSere®x\R...  Simulator device driver loaded successfully.
& 26112000 17.08:28 KEPServerExhR ... Starting Simulator device driver.
o 268.11.2010 17.08:28 Sirnulator Simulator Device Driver W6.4.135.0
o 26.11.2000 17.08:28 KEPSerelxiR...  Alarms & Events Plug-in ¥5.4.135.0
€ 25112010 17:08:29 KEPSersel=\R... Runtime service started.
0 268.11.2010 17:18:08 KEPSere®x\R... Configuration session started by Testuser a2 Default User [...
0 26.11.2010 172353 KEPSerselx\R... Configuration session assigned to Testuzer as Default Uszer...
& 29112010 15:18:36 KEPSerel=\R... EKepware Communications Server 5.4
& 3112000 151843 KEPServerlExhR...  Simulator device diiver loaded successfully.
o 2911.2010 151914 KEPSerselx\R... Starting Simulatar device driver.
o 2311.2010 151914 Simulatar Simulator Device Driver WH.4.135.0
& 23112000 151914 KEPSerelEx=\R...  Alarmsz & Events Plug-in%5.4.135.0
o 2911.2010 181915 KEPSere®x\R... Runtime zervice started.
0 29.11.2010 15:53:35 KEPSersel\R... Configuration session statted by Testuser as Default User [...
& 29112010 15:55:49 KEPSerselx\R... Configuration session assigned to Testuser az Default Uszer. ..
0 2311.2010 15:56:15 KEPSerselx\R... Configuration session started by Testuser as Default User [...

Ready

Enter a new name or leave the existing one and “Continue”

New Channel - ldentification

A channel name can be from 1 ko 258
characters in length.

Marnes can not contain periods, double
quotations or start with an underscore.

LChannel name:
|Channe\2

( Wweiter » |) Abbrechen Hilfe:

Active tags: 0of 0
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Select device driver “Siemens TCP/IP Ethernet”

‘Mew Channel - Device Driver ﬁ

Select the device driver you want to assign to
the channel.

The drop-down list below contains the names of
all the drivers that are installed on vour system.

Dievice driver:

Siemens TCF/IF Ethemet ~|

Siemens 57 MPI
Siemens 57-200
i T i

< Zuriick I Wweiter > I Abbrechanl Hilfe |

Select the computer’s own network card

Hew Channel - Metwork Interface m

Thiz channel is configured ta communicate aver
a network. Y'ou can select the netwark. adapter
that the driver should use from the list below

Select Default’ if you want the operating spstem
to chooze the network adapter for you.

Metwark Adapter:

Default ;I
Drefault

Realtek RTLBTRECT. 192168 4 35]

Whdware Virtual Et.. [172.16.145.1]

Whware Virual Et.. [172.16.52.1]

< Zurick I wieiter » I Abbrechanl Hilfe |

Leave default optimizations and confirm with “Continue”.

Mew Channel - Write Optimizations E

'ou can contral how the server processes wiites on
thiz channel. Set the optimization method and
wirite-to-read duty cycle below.

Mote: ‘Writing only the latest value can affect batch
processing or the equivalent.

— Optimization Method

" wiite all values for all tags

" wirite only latest value for non-boolean tags

«

Dty Cycle

Perfarm I10 _I:: warites for every 1 read

< Zurlick (I Wieiter » I) Abbrechen Hilfe
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“Finish” the channel settings.

New Channel - Summary

If the following information is comect click ‘Finish' to
save the settings far the new channel.

Mame: Channel2
Device Driver. Siemens TCPAP Ethernet
Diagnostics: Dizabled

Metwork Adapter:
Realtek RTLET68C... [192.168.4.98]

“wrike O ptimization:
“wirite anly latest value for all tags
10 writes per read

< Zuriick (i Fartig steflan Abbrechen | Hilfe |

Select “Click to add a device” to assign the NETLink® as a device

@ KEPServerEX - Runtime
File Edit Yiew Tools Runtime Help
DEdE @SMEaE 9 & 8 @ X | E

+ Channell Tag Mame | Address | [ata Type | Scan Rate | Scaling

. Click to add & device.
i}:‘ Data Type Examples
iE‘-‘ Simulation Examples

+
+

(& | (2]

Date v I Time | Source | Ewent

€ 2611.2m0 170824 KEPServerE=4R...  Kepware Communications Server 5.4

o 268.11.2010 17.08:25 KEPServerExsR...  Simulator device diiver loaded successfully.

o 268.11.2010 17.08:28 KEPServerEx\R...  Starting Simulator device driver.

0 26.11.2M0 170828 Sirnulatar Sirulatar Device Driver ¥5.4.135.0

0 26.11.2M0 17.08.28 FEPServerEx\R...  Alarms % Events Plug-in %¥5.4.135.0

€ 2511.2m0 17.08:29 KEPServerEx=sR...  Runtime service started.

€ 2511.2m0 1718:08 KEPServerEx R... Configuration sezsion startted by Testuzer as Default User [
& z511.2m0 172353 KEPServerEx= R... Configuration session assigned to Testuser az Default User...
o 2311.20 1518:36 KEPServerEx\R...  Kepware Communications Server 5.4

o 2911.2M0 15:18:43 KEPServerEx\R...  Simulator device diiver loaded successfully.

o 2911.20 151914 KEPServerEx\R...  Starting Simulator device driver.

0 29.11.2M0 151914 Sirnulatar Sirulatar Device Driver ¥5.4.135.0

€ 2311.2mo 1519314 KEPServerEx\R...  Alarms % Events Plug-in%¥5.4.135.0

€ 23.11.2m0 151315 KEPServerEx=sR...  Runtime service started.

& 23.11.2m0 155335 KEPServerEx R... Configuration sezsion startted by Testuzer as Default User [
& 23.11.2m0 15:55:49 KEPServerEx= R... Configuration session assigned to Testuser az Default User...
o 2911.2M0 156615 KEPServerEx\R...  Configuration session startted by Testuzer 3¢ Default User [...
Ready Active tags: Daf 0

Enter a new name or leave the existing one and “Continue”

New Device - Name

device name can be from 1 to 256 characters
in length.

Mames can not contain periods. double
quotations or start with an underscore.

Device name:

IDevicaﬂ

<zuick ([ weiter> I) Abbrachen | Hire |
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Select device model “S7-300”

g &

The device you are defining uzes a device
driver that supports more than one model. The
list below shows all supported models.

Select amodel that best describes the device
oL are defining.

Device model:

57.300 ~|

57-200

57-400
571200
MetLink: 57-300
Metlink: 57-400

<zuwiick [ weier> | abbrechen | Hire |

Enter the IP address of the connected NETLink® here.

The device you are defining may be multidiopped as
part of a network of devices. |n order to communicate
with the device, it must be assigned a unigue 1D,

‘our docurmentation for the device may refer ta this as
a"'Network ID" or "Network Address."

Device |D:

|1 921684198

<zuwiick [ weters | Abbrechen | Hire |

Leave default timing and confirm with “Continue”.

"Mew Device - Timing m

The device pou are defining has communications timing
parameters that pou can configure.

Connect timeout: Ii j: seconds
Request timeout: IZUEIEI _Ij millzeconds
Fail after I2 _Ij successive meouts
Inter-request delay: IU _Ij millizeconds

L

< Zuniick lI Y iter > Ii Abbrechen | Hilfe
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No changes at this point “Continue”

“

‘Mew Device - Auto-Demotion m

'ou can demote a device for a specific period upon
communications falures. During this time no read request
[writes if applicable] will be zent to the device. Demoting a
failed device wil prevent stalling communications with ather
devices on the channel.

™ Enable auto device demation on communication failures

Demate after |3 3: sucoessive falures

Demote far 10000 = milizzconds

™| Discard write requests during the demotion period

< Zuriick (I Weiter » i) Abbrechenl Hilfe |

The communications port for RFC 1006 is 102 (default)

Mew Device - C ications Par 5 m

Set the TCP/IP port number the device iz configured to
uze. The default for CP communications is 102 [TSAP).
The default for MetLink communications iz 1033

Enter the device's MPI D (0 - 126] for MetLink models.

Port Number. I-
MALID IEI

< Zuiick I ‘Weiter » I Abbrechenl Hilfe |

The link type must be set to “OP”!

Hew Device - S7 Comm. Parameters ﬂ

S¥-300/57-400/57-1200: Set the type of connection
link to be used in communications. Also, enter the rack
rumber and slot the CPL resides in.

57-200: Set the Lacal [PC) and Remote [Device)] TSAP
Far this device connection.

§7-200 §7-300/57-400/57-1200
Local f . =
TEAP [hex] Link Type: op
|4057 CPU Settings —|

Remote 7

TSAP (hex) Bleh [0

|4DST CPU Slat [1-31]: |2 33

<guiick [ Weiter> | Abbrechen | Hire |
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Leave byte order at “Big Endian(S7 Default)”.

Mew Device - Addressing Options

Select the byte order far 16 and 32 bit walues. Big
Endian [Motorola] iz the default byte order for the
Siemens 57 controllers. Litle Endian (Intel] is available
as an oplion

i~ Byte Order
" Little Endian

< Zuriick I Weiter » I Abbrechenl Hilfe

“Finish” the device settings.

New Device - Summary .

If the following settings are carrect click 'Finish' to begin
uzing the new device.

Name: Devicel ~
Model: 57-300
ID: 192.168.4.198

Connect Timeout: 3 Sec.
Request Timeout: 2000 ms
Fail after 2 attempts
Inter-Fequest Delay: 0 ms
Auto-Demotion: Disabled

Port Number: 102

Abbrechen | Hilfe: |

The following steps are provided as an example only and are
not obligatory for customer applications. They serve as a visual
check whether data exchange is taking place.

By clicking “Click to add a static tag” in this example, only one
item will be assigned.

@ KEPServerEX - Runtime g

File Edit Yiew Tools Runtime Help

DE 2 SMEEF | 9 ¥ B @ X

Ti? Channell Tag Mame © | Address | Data Type | Scan Rate | Scaling |
= i?ﬁ é:_—l Click to add a static tag. Tags are not required, but are browsable by OPC clients.
+ iij Da
+ i;‘-‘ Simulation Examples \il | m
Date i | Time | Source | Event | [4\]
€ 2511.2m0 17.08:28 KEPSereE=\R... Starting Simulator device driver.
& 2511200 17.08:28 Sirnulatar Simulator Device Driver ¥5.4.135.0
o 26.11.2M10 17.08:28 KEPServerEx\R...  Alams & Events Plug-in %5.4.135.0
o 26.11.2010 17.08:23 KEPSererE=\R... Runtime service started.
o 26.11.2M0 171808 KEPSererEx\R... Configuration session started by Testugzer sz Default User [...
€ 2511.2m0 172353 KEPSereEx\R... Configuration session assigned to Testuser as Default User...
& 2311.2m0 15:18:36 KEPSemeE=\R... Kepware Communications Server 5.4
€ 2311 2m0 151843 KEPServerEx\R...  Simulator device diiver loaded successfully.
o 2911.210 151314 KEPSererE=\R... Starting Simulator device driver.
o 2911.20 151914 Sirnulatar Sirulatar Dewvice Driver W5.4.135.0 =
o 29.11.2M0 151914 KEPServerEx\R... Alams % Events Plug-in %¥5.4.135.0
€ 23.11.2m0 151915 KEPSereE=\R... Runtime service started.
& 23.11.2m0 155335 KEPSererEx\R... Configuration sezsion started by Testuser as Default User [
o 2911.2M0 15:55:49 KEPSererEx\R... Configuration session assigned to Testuzer as Default User..
o 2911.210 156615 KEPSererEx\R... Configuration session startted by Testuszer a2 Default User [
o 29.11.2M0 161437 Siemenz TCRAP...  Siemens TCP/IP Ethernat Device Driver ¥5.4.135.0 | 4]
w
Ready Active tags: Oof O
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The flag word zero will be processed in the sequential program
of the connected CPU.

Tag Properties

General ] Sealing ]

|dentification

MHame: |bit mermary word

o |-

Address: |f\"|\'\"'D

EL
oL

Description: |

Data pioperties

[ ata type: m
Llient access: | ReadMwiite hd

Scanrate: (100 J millizeconds

Mote: The scan rate is only used for client applications that da nat
specify a rate when referencing this tag [e.g.. non-0FC clients)

q (n]: J) Abbrechen (Ulgemehmea) Hilfe:

Complete with “Apply” and “OK”
7.2 Starting the OPC quick Client

The Quick Client can be started via the marked icon:

|@ KEPServerEX - Runtime E]

File Edit View Tools Runtime Help

NS 2 SMBEAF | 9 & @ @& X

+ E? Chatinell Tag Mame | Addrezs | Data Type | Scan Rate | Scaling
=& Channel2 ¢/ bit memor... M0 Quick Clisnt [ Hene
M Devicel

¥ i? [ata Type Examples
+ E? Simulation Examples

<
Date | Time | Sounce | Ewent | ~
€ 25.11.2010 170828 KEPServerExNR...  Starting Simulator device driver.
€ 23.11.2010 16:14:37 Siemens TCPAP...  Siemens TCP/IP Ethemet Device Driver W5 4.135.0
~
Launch the OPC Quick Client. Active tags: 0of 0

The program module OPC Quick Client opens and the status of
the item is displayed by marking the channel and device you
previously created

| OPC Quick Client - Unbenannt * E]

File Edit Wiew Tools Help

DE o efa & %

=1 Kepware KEPServerEX W5 | | ltem D | Drata Type | Walug | Timestamp | Guality ‘ Update Count
(3 _AlamsEvents 0 Charnel? Device] _Fack Byte i 1618285859 Good 1
{3 _system @ Channel2.Devicel._Slat Eyte 2 16:12:28.859 Good 1

(B3 Channell _System
(B3 Charrel Devicel
(E3 Channel Devicel._System
(B3 Channel2. Svstern

(£ ChannelZ Devicel._System

M hannel2 Devicel bit memory word — word 161287  1E:19:32.890 Goad B5

(E3 Data Type Examples._System w
< >
Date Time Ewent ~
ﬂ 2911.2010 161829 Added group 'Data Tppe Examples._System’ to 'Fepware KEPServerEx Ve
o 2911.2000 161829 Added group 'Data Type Examples. 16 Bit Device._System' to Kepware KEPS erverEx WE.
& 23112010 161829 Added 16 itemns to group 'Simulation Examples.Functions' T
Ready 249
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8 PROCON-Win V3.2 (GTI Control)

The following steps must be performed in the described se-
quence (Version July 2011):

8.1 Configuring the driver and connection

e Open PROCON-WIN 5 VisuDesigner .
e Create a new project by pressing ,New Project”

2ri PROCON-WIN 5.3 VisuDesigner

File Edit View Tools Window Help
DI X 2 B0 et i D P - B
f'roiecmee a @Slarlpage]

= VisuDesigner

“@&=  PROCON-WIN 5" noo

Version: 5.3 ...
Build: 005.003.002.005 . . n
Build-Date: 27.01.2011 G| T

Handling Project History Tutorials
i )
12 ) /
¢ & {
) /\

1 MNroject Tutoris
NowCroes JNETLink_RFC1006.pwd
NN

Bibliothek_Pw5.pwd

y Open Project ) Bibliothek_GLT.pwdl
Library. pwd
| DemoProject pwd
*/ DemoControl.pwd

€ HELMHOLZAluschnat

e Choose “Compact” and name the project.
e Confirm with “OK”.

New Project
Create a new PROCON-WIN Project
Plea e name and type of new project

Prcwec| [ NETLink_RFC1006_en | |

CAPROCON-WINWisuDesignersworkDatah

OWwindows CE
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A new project is created and opened immediately.
e Double-click ,Tag”.

ori PROCON-WIN 5.3 VisuDesigner - Project ‘C:\PROCON-WINWisuDesigner\WorkData\NETLink_RFC1006_en*

| File Edt View Tools ‘Window Help
a3 3 X 0 (A = 0 [ [P, ) Find and Replace = || Default '
e QSlallpagel

{2 Startpage
(= Project .
(=% Configuration L
] Project Version: 5.3
Alert L Build: 005.003.002.005
=] Logbook Build-Date: 27.01.2011
/| Ribbons
] Touch Handling Project History Tutorials
| Style
- Q
; & G -
=) Data v
S y 0 Al Tutorial
B Tag count with arrays 1
E Tagcountwithout anay 7\‘ < >
Numeric 1 @

ﬁ HELMHOLZ\uschnat  Created new Project: NETLink_RFC1006_en

e From the menu bar click on “Tag” -> “Driver selection”

ori PROCON-WIN 5.3 VisuDesigner - Project ‘C:\PROCON-WINWisuDesigner\WorkData\NETLink_RFC1006_en*

| File Edt View Tools wndow!
WO B ES T New o | 0 [[) 23| Find andReplacs > E‘.u'fﬂ' O oY M=l

Project tree op Show tag class editor
g :::"TCI 4 Driver selection I R Type 4B Stuctueinstanceelement ® PC + FieldSize 4 Prioty 8 Accesslevel +
=] Logbook o & & = = =
5 Networl ———— priable ‘1,. Num F ) 1 0 0
. " Hide Filterline .
| Ribbons jariable ‘. Bool Y 1 0 0
] Touch e Show Group By Box ble @y Sting g 10 0 0
B Sve : Bodl 1 0 0
@ Process comection | £ Reset S2ng } Do e : i i
| = Fit To Screen = =
%) Stuet & Fit To Contents
&-@ Data sl B
4] Alerts and Groups [] Reshow columns | »
& Alertdisplayg
4] System Aletts v‘
= 3

B Tag count with arrays I

|

=] Tagcounl will‘mulmw 7!
ﬁ HELMHOLZ\uschnat  Created ne; ‘F‘voiecl: NETLink_RFC1006_en

o Select ,585-§7-COMBI RFC 1006”.

e Click the button contained in the cell under the column

“INI-File”.

Driver Selection

|s Active H Name +# D 4 INI-Fle <4 Ar 8 Inp 4 Outp 4 BiDi 4 Logi # Nume 4+ Skin 8 4

E @& B @ m [m @ E [ = =
[] 39%4R) Trei. shot_na.. S

[] Hilscher-.. Trei.. short_na.. O

L]

0

~ OO W N

.. Trei.. m
[] BECKHO.. Trei.. short_na.. 3
| | A0 _ADTL 3 E I} | s | | s | | s | - £/ )
[ oK l [ Cancel l
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e A text editor opens.
e Search for this in color highlighted line:

- BX

t Editor

s agl = "/type=s5_h1 /agaddr=080006010000 /rtsap=READREAD /wisap=WRITWRIT /ltsap=PCPCPCPC" -~

; Beispiel einer TCP/IP-Verbindung zu einer S5 mit RFC 1006

; agl = "/type=s5_osi /ip_adr=213.128.16.100 /rtsap=READREAD /wtsap=wWRITWRIT /itsap=PCPCPCPC"
Belsplel einer H1-Verbindung zu einer 57

cagl = llype-s7 hl /agaddr-UBEllJDSlJ] 0000 /rtsap=[03.03] lwlsap-[l33 03] /ltsap=[03.03] /uni=yes"

3 Belsplel einer TCP/IPVerbindung zu einer 57-400 mit RFC 1006

;> ag0 ="/type=s7_osi /ip_adr=213.128.16.100 /rtsap=[03.03] /wtsap=[03.03] /tsap=[03.03] /uni=yes"

; Beispiel einer allgemeinen passiven TCP/IP-Verbindung

> agl = "/type=tcp_p Awrite_port=1111"

Protokollieroption:

wenn diese Option aktiviert wird, so legt der Treiber die 3

] L)

e The highlighted line is to be replaced with the following:
ag0 = "/type=s7_osi /ip_adr=XXX /rtsap=[02.0Y] /wtsap=[02.0Y] /ltsap=[02.0Y] /uni=yes"

e In place of the “XXX” enter the IP address of the NETLink

e Replace every “Y” with the MPI address of the PLC con-
nected to the NETLink

e The resulting string should look something like this:

Text Editor

s agl = "/type=s5_h1 /agaddr=080006010000 /rtsap=READREAD /wisap=WRITWRIT /ltsap=PCPCPCPC" -~
; Beispiel einer TCP/IP-Verbindung zu einer S5 mit RFC 1006
; agl = "/type=s5_osi /ip_adr=213.128.16.100 /rtsap=READREAD /wtsap=wWRITWRIT /itsap=PCPCPCPC"
j: Belsplel einer H1-Verbindung zu einer 57
sagl= llype-s7 h1 /agaddr-UBEllJDSlJ] 0000 /rtsap=[03.03] lwlsap-[l33 03] /ltsap=[03.03] /uni=yes"
Belsplel einer TCP/IPerbindung zu einer S7-400 mit RFC 1006
;> ag0 ="/type=s7_osi /ip_adr=213.128.16.100 /rtsap=[03.03] /wtsap=[03.03] /tsap=[03.03] /uni=yes"
; Beispiel einer allgemeinen passiven TCP/IP-Verbindung
> agl = "/type=tcp_p Awrite_port=1111"

; Protokollieroption:

wenn diese Option aktiviert wird, so legt der Treiber die 3

] L)

e Close the text editor and driver selection screen by press-
ing //OK”
e From the menu bar press ,Tag” -> ,New” -> ,Num*

-x1 PROCON-WIN 5.3 VisuDesigner - Project ‘C:\PROCON-WINWisuDesigner\WorkData\NETLink_RFC1006_en’

File Edit View Tools Window | Tag LHeb

93 eoo ™ 13| Find and Replace ~ B (e de el o onl B8 BH R

Project tree 2 Show tag class editor 40 Num I
%::’ITC‘ 4] Driver selection G 5| Stuctwe instance element 48 PC 8| FieldSize ) Prioity | AccessLevel
1] Logbook £, PLCimport [T Al [l = = =
B Netwe T hibe [faNum 1 0 0
3 Hide Filterline 2
/] Ribbons bisble [0 Bool 1 0 0
“] Touch e Show Group By Box ble [ Sting 10 0 0
| Style — 5
. =) : “ad Reset Sizing [03Bocl g 1 0 0
=4 Process connection ‘H Bool 1 0 0
| = Fit To Screen : =
| St & Fit To Contents
=) Data -
] Aletts and Groups | (] Reshow columns |>
4] System Aletts v

i y Al
B Tag count with arrays T

B Tag count without anay

vl

ﬁ HELMHOLZ\uschnat  Created new Project: NETLink_RFC1006_en
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o Fill the table with the following values:

Name user-defined

Decimal places 0

Min PLC -128

Max PLC 127

Min PC 0

Max PC 256

Driver $5-§7-COMBI RFC 1006
10 Input

Baustein-Typ MERKER

Format S7-BYTE

e Values not defined above are left at default.

Name R Type H SHBFR B BB MEMEMAMB Defah® M Diiver & | & 1 (1] BB B[] s Lls
Cmm & B s=- -=--0 & B & B s&E B E& EEE @
1 StaticBooleanOff ]..‘l‘ Bool g 1 00 O Merker

] StaticBooleanOn IH Bool £ 1 00 Merker

3 DefaultStingVariable | Sting 0 00 Default 40

4 DefaultBooleanVariable IE Bool FY 1 00 Merker

5 DefaultNumericVariable |u Num 1 0 0 2 000 1000 0.00 1000 0.00 Merker

[ NETLink ihNum E 1 0 0 0128127 0 256 0 S5-57C.. || O MERKER 0 0 S7BY.

Save the project (STRG+S).
8.2 Creating a Picture

Right-click on “Pictures” and select “New”.

211 PROCON-WIN 5.3 VisuDesigner - Project ‘C:\PROCON-WIN\WisuDesigner\WorkData\NETLink_RFC1006_en"

File Edit View Tools Window Tag Help
o3 3R B XI2ES19 el i DR Bliows o s [
EEEY | siaipee ¥ T L

;’ ?,DBE'ctm"Ecm" Al Name R Type B SHA R A BAE MR MBH MR D AR Dive
imemeter
27| Timeswitch [A. Bl wi=: =:=:-:[A] B AR (B @ wwe[[Al
oiE i DefaultNumericV ariable |u Num F3 1 0 0 2000 1000 0. 1000 0.00 Merker
3 Al | I New I elauItBo.oIean\:t'aviable |ﬁ Bo.ol FY 1 i0.i0 O Merker
I E Lol @l new System picture iefaultStingYariable | Sting g 0 00 Def.. 1
=43 Script Close al al!cgoo:eang;; |Ei :00: E : E E mer:zel
aticBoolean ool erker
% Delete Picture b L4 Ol
0.0 M |
Sort by Name
B Picture prope Sobyimbey

G License

<
ﬁ HELMHOLZ\uschnat  Created new Project: NETLink_RFC1006_en

e A new Picture is created and displayed
e Click the tab “Dynamic” under “Items” and then “Numeric

Field”
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e Now right-click on the white area beneath “Dynamic Sym-
bol” and choose “New” -> “Numeric Digit”

File Edit View Tools Window Picture Help

W SlGEEEL X289
“JBI g&|%,;vA<
IR iy =~ o |

1™ .Y wd
Project tree ® | £ Startpage || Tag (4] Picture_00000001 x|
| DDBC-Connection A ~ | Static| Dynamic
] Timemeter —
] Timeswitch B [z il E E
i . =l[e] |
o Alamfenster = IEI
.~ Logbuchfenster —
I (00001) Picture_00 Numeric Field
Eb.; Script y Name 4 Attibute group
(!
- T oetai
< | @ ™ List | |
E Picture propertys 4 ) o — Symbol
i : T EZC I [ tems | Layer B
Pms 00000001 L8 Growp s
—= #7T | numeric Digit | New »
Obiject Attribute J Boolean Digk s value hstance valle
Picture_00...

ﬁ HELMHOLZMuschnat  Created new Project: NETLink_RFC1006_en

e Press the button contained in the cell under column “In-
stance Value” row “Value”.

Numberfield Control E]

Class: NumericDigit_0

“‘ a8 Default view | 4 Tag view
Obiect Attribute group Attribute: Class value Instance value
= vex NumericDigit_ 0 = |7 Display Value 1o DelaullNumeric
DB-Access No DB-Access
L Transparency
= Font Avial; 12pt; Regular;...
e E]
Lol ke Test Color I Colr [5-255, R=0..
| M & Display Background color [ Color [4=255, R=1..
1 Format ;
i = ) Format Number system Decimal
|0 g ineut )
b Zetos before decimal.. [m]
[J =g Position
Define format O |

] [ visiility |
Rotation |
| linking
| [0 @ Swel |

e Choose the afore created tag and close the window with
//OKI/-
PIX)

Tags
[ NETLink I I |
Name R Type B Stucture instance element 4 FieldSize B Priority
(mw [= Num = =
1 DefaultNumericV ariable ‘1_. Num FY 1 )
2 Al 1 ——
< | >

o Close “Numberfield Control” by pressing “OK”.
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i

If no start menu entry
exists, you can find the
file “projects.pcs” in
the folder “\PROCON\
WIN\Projects”. It can
be opened with a texte-
ditor!

36

e Create an instance of the newly created numeric digit by
pulling it on the picture using drag & drop.

211 PROCON-WIN 5.3 VisuDesigner - Project ‘C:\PROCON-WINWisuDesigner\WorkData\NETLink_RFC1006_en’
File Edit Yiew Tools Window Picture Help

AR E R EX 2D &

A B L U S ) -8 4 W =
ECNRS i = ™

..‘JQ;J!

Pojecttree % | & Statpage || Tag 4] Pictue_00000001 | x | |tems L
£ ODBC-Connection (@ ~|| static Dynamic | 40 |
] Timemeter "‘
=  IEEEE
g @ [EIE]
o T [=)=][a)al
[ Logbuchfenster O g —
[l 1l (00001) Picture_00 Numeric Field
=4 Seipt T Name | Attibute giou A
‘ LK
N7 Vi
< | & | | >
|2 Pi — | >
icture prope: = ra
e o [no24r7e8)  [mawvzs)  |jnses) [[usng [ B tems | Laper
Propertys a
Picture_00000001 a8 Default view | . Tagview | Instance view o Automationobjects
& NumericDigit_0 = =
Object Attribute gro Attribute Class value Instance value A
(= == Numeri.. = Geometry Origin X 152 —
Origin Y 61 o

€ HELMHOLZ\luschnat  Created new Project: NETLink_RFC1006_en

e Save the project (CTRL+S) and from the menu bar press
“File” -> “Create Runtime”.

211 PROCON-WIN 5.3 VisuDesigner - Project ‘C:\PROCON-WINWisuDesigner\WorkData\NETLink_RFC1006_en’

File lEdt View Tools ‘Window Picture Help
J riew proi AAN=NEYERE N - [RON -
g OpenP U s [ Som o d = ¢
- - ~ 5~ !
_|Cé Create Runtime ) |
o Upmmewmme cukRz - =
?E o e i % Startpage | ] Tag, (41 Picture_00000001 | x | ltems L
B o : A Stalic | Dynamic | A0 |
9 Save Project Ctrl+5 ‘
> D |
|=) Save Project As =) 0
X Delete Project O OD EI
oroTo Numeric Field
./ Close Project umeric Fiel
OL'b— Name 4 Attribute grou A
" [ ELF
Vi
b < >
[ 4E) print Ctri+p | S |
| E] 4 . : o
) printpreview  culsshit+p  Poas7es) (24519 [samsn |45 [ B tems | Laper
5
» peettys 7
Exit F’iclule_DDUD1 a8 Default view | L Tagview | 0 Instance view _g: Automationobjects
— i NumericDigit_0
Object Attribute gro Attribute Class value Instance value A
(= == Numeri.. = Geometry Origin X 152 =
Origin ¥ 61 v

ﬁ HELMHOLZluschnat ave Froject: LAFHULUN

WINWisuD esianerworkData\NF Tlink REC100R_en owd

e Open the Windows start menu and select “Aktuelles Pro-
jekt” under “All programs” -> “GTI” -> “PROCON-WIN 5.3”

nae

2= PROCON-WIN YisuCompact

EE?, PROCON-WIN VisuDesigner
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e Enter the name of the project in the text file and save it.

I project.pcs - Editor E]@E]

Datei Bearbeiten Format Ansicht ?
NETLink_RFC1006_en

e Now start ,,PROCON-WIN 5 VisuCompact”.
e A numeric field containing the content of the flag byte O
in decimal format should be visible now.

254

e To close VisuCompact double tap “Esc”

NETLink® PRO family Application Examples
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9 VisAM Win32 (VISAM GmbH)

The following steps must be performed in the described se-
quence (status May 2008):

9.1 Configuring VisAM Win 32

Open the program module VisAM editor

e Communication -> Select channels
e Click assignment 1 in the communication channel selection.

X]

VisAM Win 32 Kommunikationskangle (VKK)

Kommunikationskanal | Kemmunik stionsmodul -
Zuordnung| Eigenschaften

0 Difline
7% unbenutzt
2 | unbenutzt
3 | unbenutzt
4 | unbenutzt
5 | unbenutzt
B |unbenutzt
7 | unbenutzt
8 |unbenutzt
9 WOK-TCP/P [Client]
1]
1

DDE-Direkt [Client]
UNE bebare (EUK Arial d

Schliefen | Weiter |

In the selection, select assignment “Siemens S7 Ethernet ISO on
TCP” as the VKM name and confirm with “Continue”.

Auswahl VKM

VEK: 1

VEM-Mame

unberutzt

S7 MPI-Bridge [R5232/Ethemet]
Siemens SIMATIC 57 MPI-Adapter
Siemens SIMATIC 57 Ethemet Visih
Siemens 57 Ethernet FetchAwrite A55-Link)
Siemens SIMATIC 57-200 PPl-Adapter
Siemens 57 Ethernet 150 on TCP
Siemens SIMATIC §7 PRODAVE
Siemens SIMATIC 57 HMI-Adapter

57 IBH-Met [IBH-Link]

S7 ARCOM [Arcnet]

Siemens SIMATIC WinAC

[P ©TTCUCCCl

Schliefen | Wweiter |

Click the remote name and...

VKM-Eigenschaften

YKM: Siemens 57 Ethernet 150 on TCP
Fehlertoleranz 1]
Femate-Mame 192.162.4.38
2/2

Schliefen Wweiter
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NETLink® PRO family Application Examples

...enter the IP address of the NETLink®

VisAM Win 32 Editor

Geben Sie Remote-MName ein [maximal 50 Zeichen).

Abbrechen

192.168.4.38

Confirm with “OK” and click TSAP...

VisAM Win 32 Editor

Geben Sie TSAP ein [maximal B0 Zeichen].

Abbrechen

...and enter address. In this case 2/2 for bus address 2, rack O,
slot 2 (see the relevant chapters with the “Address conversion
table” in the NETLink® manual).

Confirm with “OK”.
x

VisAM Win 32 Kommunikationskanzle (VKK)

Kommunik ationsk anal| Kammunikationsmadul =
Zuordnung| Eigenschaften

0 | Offline
1.5 Siemens 57 Ethernet 150 on TCP
2 | unbenutzt

3 unbenutzt

4 | unbenutzt

5 | unbenutzt

3 VOK-TCPAP (Clignt)

10 | DDE-Direkt [Client]
11 [UNE nbann (B Anial j

e |

You have now created the communications channel and can
apply the settings with “Close”.
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40

Select Communication -> VDF Data Field

VDE Gruppenauswahl Prozessvariablen

Gruppe 0

000: 001 002 003 004 005 006 O0O7 008 003 o0 o1 M2 M3 04 ms
me | M7 | Mg M9 020 01 | 022 023 024 | 025 026 027 028 023 ) 030 03
032 | 033 034 | 035 036 037 038 033 040 04 042 043 044 045 046 047
042 | 043 080 051 052 053 084 085 OB6 057 08B 088 060 OR1  0B2  OB3
054 | 0B85 | 086 067 0688 0683 070 071 072 073 074 075 076 077 078 073
020 | 021 082 083 084 085 086 087 088 089 030 091 092 092 094 095
036 | 037 033 | 033 900 900 | 902 | 103 | 104 | 905 | 906 | 907 ) 108 ) 103 ) 1100 11
2 13 114 15 16 17 18 118 1200 1210 122 123 124 15 126 17
128 129 130 131132133134 135136 137 138133 1400 141 142 143
144 | 145 146 | 147 145 143 150 151 152 153 154 155 156 157 153 159
160 | 161 | 162 | 163 | 184 165 166 167  16B 163 170 171 172 172 174 175
176 | 177 | 178 | 173 ) 180 ) 181 | 182 | 183 | 184 185 186 187 188 183 180 139
192 | 193 194 195 196 197 188 199 2000 200 202 203 204 205 208 207
M08 203 20 2 A2 A3 A4 A5 A6 A7 218 218 220 A 222 223
224 | 225 226 227 228 229 230 23 232 233 2 2 23 2 23 1
240 | 241 242 | 243 244 245 246 247 4B 243 280 251 252 283 254 255

QK | Abbrechen | Iv Belegung anzeigen

Select Group 0 and click the “000" field to activate process
variable selection.

VDF Prozessvariablenauswahl 0ri_I_
YDF Gruppe: ’Wg |GruppeD I~
m’f |Elohal Mame \{":;ablen- tggﬂ aluar::;:j- hD:'l;: Worl-| s nzat| Modus ﬁ::::ll Yorgab i‘
0 Min. Wwert YDF abzolut 1 0 0 0 1 Zyklizch max, 2
1 | bax wert YDF abzolut 1] 1] 0 0 1 Zuklizch max, 100
2 | Meldetextadresse VDF abzolut 1] 1] 0 0 1 Zuklizch max, 5
3 VDF abzolut 1] 1] 0 0 1 Zuklizch max, 1]
4 WDF abzolut a i] 0 0 1 Zyklizch max 1)
5 i i 1 Zyklisch ma i
[ VDF abzolut a u] o o 1 Zyklisch max, 1)
7 YDF absolut 1} 1] 1] 1] 1 Zyklizch max. a
8 YDF absolut 1} 1] 1] 1] 1 Zyklizch max. a
9 VDF absolut 1} 1] 1] 1] 1 Zyklizch max. a
10 VDF absolut 1} 1] 1] 1] 1 Zyklizch max. a
11 VDF absolut 1} 1] 1] 1] 1 Zyklizch max. a
12 VDF absolut 1} 1] 1] 1] 1 Zyklizch max. a
13 VDF absolut 1} 1] 1] 1] 1 Zyklizch max. a
14 mar, 1]
15 mar, 1]
16 mar, 1]
17 mar, 1] j
Kammunik stiogzk anal| Kommurik ationsmodul
oK | Abbrech Zuprdnung| Eigenschaften
0 Offine
1. Siemens 57 Ethernet 150 on TCP
2 | unbenutzt

Coupling channel 1 is referenced to the previously defined
communications channel. Confirm with “OK”.

VisAM Win 32 Editor

\_‘{‘} Aktuele Anderungen vor dem Test abspeichern?

( Ja b Mein | Abbrechen |

Save the settings.
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9.2 Starting visualization
Select Project -> Test (hotkey F5)

Test; Unbenannt ﬁl

" DOffline
i
o~
iy

Parameter:

Autastart erzeugen ‘

Start ‘ Abbrechen ‘

Select “Online UL” and click “Start”

Process visualization opens and the communications link is
started.

a\"isﬁﬂ §§2 ?&3&4 &5 ril u: ?
-

The connection monitor switches from “offline” to “online”
mode.

avism ﬁz :j?'\ 3['(%4 VAY fi1 u: 2
I

The transmission information can be displayed in Info.

kK 1= Z20:65 Rk:0 MaZ5385 MAF.584 MST:0 RAZ0 RAFO RET:0
TCP/IP_C3923 MAZD MAFD MST:0 RAZ0 RAF:O RET:0
DDE_DCO Mas 0 MAF:0 M5T:0 RaZ0 RAF:0 RST:0
SCHR.A 0 WOKZykl: 26011 -T:4.874 max 4,922 L-Er. G 0FV:0
WOKUL Y241 Spsi2

Sonpts Anz: 0 55T =0K 5.T=0,000 Max=0,000

NETLink® PRO family Application Examples

41



10 WinCC flexible 2005/2007 (Siemens AG)
The following steps must be performed in the described se-
quence (status April 2008):

10.1 Configuring connections

Start WINCC flexible Project and open the connections in the
communications register:

Select communications driver "SIMATIC S7 300/400"

L]

e Interface: Ethernet

e The operator panel address is the local IP address of the com-
puter network card

e Access point: STONLINE

e The Control address is the IP address set in NETLink®

e The Slot is the MPI address of the CPU to be addressed

{4 WinCC flexible Advanced - ProjektTP170b. hmi

Projekk Bearbeiten Ansicht Einfligen Format  EBildbausteine Extras Fenster Hilfe

New ~ b . - X i\'._g(’/;)“!uvgévgr'Eﬁ‘&ﬂ,‘,SIMATICS?EDD/...V'EQ?E%__
Deutsch [Deutschland) =

BRI T i = | oce

lees PRO__0D
E--E_- Bediengerast_1(TP 1708
=55 Bider

-a Bild hinzufligen .

-1 Worlage

euerung_1

[ PIC

—]--ﬁ Kommunikation

== Wariablen

---.S. Werbindungen
= Zyklen

—]--ﬁ teldungen

B4 Analogmeldungen
B4 Bitmeldungen
]--% Einstellungen
]--m Fiezeptuien

]--% Text- und Grafiklisten
]--ﬁ Benutzersenwalung R
]--F_- Gerdtesinstellungen lml Bereichszeiger
—]--ﬁ Sprachunterstiitzung
i@ Projektsprachen

Steuerung_z

- Giafiksammiung TP 1708 mano Station %
- £ Projektiente Schnittstelle
]--E “widrterbiicher P =
3 % Stukturen Ethernet by
]--ﬁ erzionsvenvaltung
Bediengerit Steuerung
T fl
¥R &
IF
® 192, 168, 4. 45 2 1. 4. 3
D150 Steckplatz
Die Adresse kann nur am Ger &t 3
projektiert werden Baugruppentrager i}

Zugangspunkk ‘S?ONLINE ' [ ZyKlischer Betrieh o
< S =
% Objekte
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10.2 Configuring the PG/PC interface

In the control panel, open the “Setting the PG/PC Interface” mod-
ule.

e Select the network card with protocol “TCP/IP” installed in the
computer system as the “Used Interface Parameterization”.

e Check whether “S7ONLINE (Step7) --> TCP/IP ->...“ is active for
“Access point of application”

e Confirm with “OK”.

PGIPC-Schnittstelle einstellen X
Zugriffsweg ]

Zugangspunkt der Applik.ation:
[STONLINE  (STEP71  -» TCR/IP -> 3Com EtherLink L 10 v |
[Standard fir STEP 7]

Benutzte Schnittstellenparametrierung:

[TCPAIF > 3Com EtherLink <L 10/1 . Eigenschaften..
B TCPAP > 3Com 3C00TPO-basiert A Diagnose...

TCPAP -» 3Com EtherLink XL 1041

B TCPAP -» Neigwanlp
B9 TCP/AF[Auto] > 3Com SCI00TPO4
{

>

[Parametrierung lhrer MD15-CPs mit TCPAP
Pratokoll [RFC-1008])

Schrittztellen
Hinzufiigen/E ntfernen: Auzwahlen...
Abbrechen Hilfe

All variables that are linked to “Controller_1” can now be accessed
via the RFC 1006 protocol.

NETLink® PRO family Application Examples 43



11 ZenOn V6.2 (COPA-DATA)

The following steps must be performed in the described sequence
(status August 2007):

11.1 Configuring Zenon

Start Zenon and create a new project or adapt an existing one and
define variables.

Configuring variables:

o

| Datei Bearbeiten Bilder Option Eenster Hilfe
HitB2REIRAQA M S (E2ATE |- E HIDBE LTS Y | SAL HE 88 &2
D RRL el [RE (SEEy DNO0COD " TL JumsRLSEHODE

®

IProjekt Arbaitsberaich v 1

-flg Arbeitsbereich T:4HMI-Project & | |Status Name | Kennung| Einheit |Met... |Datenbaustein Offset Bit-Mu... fusrich... Treiber Datertyp | Machk...
E|" TEST_1_VERE (Statty | - |57Fite [f@|Fiter [F@lFiter. 5RJFi B2] Fitettewt [@Fite. [@iFit. SR Fiter |57 Filtertest BF] Fitertext |EE|Filter. AP
-8 RGN DE17 o 17 z STTCP3Z - 57 TCP-IP INT
a
a
a

Z11 1] 11 S7TCP32 - 57 TCR-IP LDINT

- #% Datentypen 710 o 10 SPTCPAZ - 57 TCP-IP UDINT

@ Feaktionsmatiix Ml 1 i} 11 S7TCPE2 - 57 TCP-IP NT

W Zuweisungen

- ® Bilder

I:I---Q: Funklionen

----- @ Sprachtabelle

----- :l Archivserver

- "'5 Rezepte

----- d; Feitsteuerung

[]---ﬁ; Skripting

STRATOM (IECE13
Scheduler

o Weregelungsn -

----- Mezzage Control

oo oo
oo oo

0
0
0
0

1 . ;

i m Projektmanager l& Symbole |

HEEE pm ‘

x
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11.2 Setting the driver

e Mark “S7 TCP-IP”
e Press “Click here->” in the configuration

Zenin

:: Datei Bearbeiten Bilder Option Eenster Hilfe
H +BR2hAQ |k Se IE2Wk|+4HE | E0E
(LB Ry AR CEEE| » OGO T
| Projekt Arbeitsbereich

Eﬂ Arbeitsbereich 'D:\HMI-PrDiecﬂ;I Statuz Bezeichnung 1 | Beschreibung D ateiname
= [@§ TEST_1_VERB lﬁlaltlj . [ Filtertext @ Fitetewt R Filt

O h
1@

=@ Variablen Mathematik Yariablen MATHDR32
3 Treiber Systern Variablen SYSDRY

- # Datentypen Interne Yariablen Intern
E Fieaktionzmatrix 57 TCP-IP — S7TCRIE

g gdzuweisungen V1 Markieren!
" Bilder
& | Furklionen

Splachtabelle = 5
A EE .

m Frojektmanager I& Symbole
= EE @z

=] allgemein

x

Beschreibung

Bezeichnung 57 TICR-1P
o

Dateiname STTEPaZ

Konfiguration hier klicken -=

11.3 Driver configuration

“New” button:

Enter data

(remote IP address = IP address from NETLink®
Remote TSAP = MPI address of PLC)

First the “Save” button

Then “OK” button

Konfiguration

ﬁ Aligemein | 57-TCP Yerbindung TCPHIP'
FirSt the ”S(ZVE” button “Wehindungsdater: IDefauIt.iso e
Abbrechen |

and only then confirm
//OK//'

—Yerbindungen;
Werbindungsliste: Busadresse: ID

Connection name o | ‘Werhindungzname: IS?'L"'-“-T*LF'I

S7-LAN_PI a
Femate [P address [primar):
NETLInk FRO
|192188438 <—|P Adrecse
Femate [P address [altemativ]:

e e

Local TSAP: Remate TSAP:
| 000 fhew | 0206 jhew

Meu Lischen | Bearbaiten I Speichern | MPl-Adresse AG = 06
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11.4 Integrating variables in images

Configuring images

rentn - Picture 0

Datei Bearbeiten Bilder Dwn, Elemente  Wekk. Elemente Kontrolelemente Option Fenster Hilfe
Hirmaelalaamee E2ATL|(L4HE BB LGSR <

»  ONOOGDH A TL | ol mmug|

| Projekt Arbeitsbereich

o=

[*-&3 | Funktionen
@ Sprachtabels
ﬂ Archiveerer

E]- ‘a Fiezepte

5 Zeitsteuerung
[]---;@ Skripting

5 STRATON IEC B113
H Scheduler
 Yemegelungen
! Message Contral
'g Meniiz

8@ | Report Generator

<

E--ﬂ Arbeitzbereich 'D:\HMI-Proiecl: Chatuz Name

.. |

Filterte

Picture Dﬁ f\
1, "Picture"
aktivieren

----- ﬂ Benutzer s ‘I I
}I

[ 111 |

IR e R et
DB17.DBW?2 zshlt Sekunden

e e e

4294967295

(M=l

T T
I |
[ T T
/Z1ﬂ:5increment pro Sekunde
1 e R T e (T R BN

4294967295

2 T

|
H Prajektmanager I& Symbole |

|’; Ficturg 0 |
i

“ulEEE =

-

/

1#| position

=]

Runtime

['2, ‘ariable zuordnen

=]

Sichtbarkeit/Blinken

H

Sollwert setzen

o

¥Yariable / Funktion

/
/
v

Yariable

017

g

YBA

wert_2

Finally, start the runtime:

zeniin

- Datei Bearbeten Bider Option Fenster Hife

‘Hrmalshaq

Dy | BL T Fy | e v e b

S e

T4l | %
P

|Pr0jekt Arbeitsbereich

Arbeitsbereich 'D:\HMI-Projectsh(
! KUPFER_MEBG

TEST_1_VERB [Startprg
P Wariablen

&% Bilder

T B O

Runtime starten mit F5

oder higr

gekennzeichnetes lcon
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A firmware update on
the NETLink® WLAN
must always be per-
formed via the network
socket.

12 Troubleshooting

The points described here show some typical errors that can occur
when using the RFC 1006 function.

Please also refer to the descriptions for troubleshooting in the ac-
cordant NETLink® manual!

If a problem is not described here and this manual does not pro-
vide any information on how to remedy it, the support of Sys-
teme Helmholz GmbH will gladly help you to solve the problem.

Q: How is a firmware update performed in a NETLink® adapter?
A: The following steps must be performed:

1) Download the up-do-date “SHTools” software from the Systeme
Helmholz web site and install this on your computer.

2) After “SHTools” has been started, make sure that the appropri-
ate NETLink® product is activated on the status bar

[ZT stiTools v3.64 - fw02 101 x|

File  Adapterfproduct Diagnostic USE-Adzapter NETLink Help Language

IRz a0 | 2afl=> 25 |@-|&-

eimholz’

compatible with you

_§ | NETLink PR Andy xun-881-MP111 NETLink PRO_D

If there appear another product, so simply press the right mouse

button over the status bar and select the product based on its

name and order number in the dialog box that then opens.
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3) After you have pressed the “Adapter->Update adapter” menu, the
dialog box shown below appears (example):

x
@ Deszcription | Yersion | Yolume | | M ame of bi.. |

Bios

& METLirk BIOS Y1.42 Feb 26 2008

(® METLink BIDS Y1.42 Feb 26 2003 f BEL_METL...
Uszer program

&% METLink PRO %1.54 &pr 20 2009

(®) METLink PRO +1.56 Jun 52003 @ METLink,_...

(O METLink PRO W1.42 Feb 27 2003 METLink,_...

v Don't update if wersion is equal Abhart I Update

To perform an update from a firmware version lower than V1.42
to a version higher than V1.42, it is first necessary to update to
version 1.42 as an intermediate step.

After that, an update to all higher versions can be performed in a
turther step.

Q: Why do I get an address conflict when trying to communicate
via Step 7 with the RFC 1006 mode activated even though the sta-
tion-related address has been adapted in the driver?

A: You have probably changed your own address in the Web in-
terface (default = 0). The NETLink® automatically tries to go
online with this address on the bus in RFC mode. Conflicts will
occur if another node uses the same address. In this case, the al-
tered entry in Step 7 is ignored. Check the status of the active sta-
tions in the Web interface.

Q: What must I observe when calling your technical support?

A: Please have all relevant data of your system constellation with
the connected stations and program modules at hand when you
contact technical support at Systeme Helmholz GmbH.
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13 Directory of Sources

INAT-OPC-Server
(http://www.inat.de/index.php?18&backPID=18&tt_products_sof
=236)

InduSoft Web Studio v7.0
(http://www.indusoft.com/indusoftart.php?catid=1&name=IWS/
webstudio)

InTouch V9.5 (Wonderware GmbH)
(http://global.wonderware.com/EN/Pages/WonderwareInTouch-
HMl.aspx)

KEPserverEx V5.4.135.0
(http://www.kepware.com/Products/OPC_Servers.html)

PROCON-Win V5.3 (http://www.gti.de/index.php?id=45)

S7/S§ OPC-Server
(http://www.helmholz.de/prod.d,18_30_34.html?p_id=39)

VisAM Win32
(http://www.visam.de/03_produkte/visam/index.php)

WinCC flexible 2005/2007
(http://www.automation.siemens.com/hmi/html_00/products/sof
tware/wincc-flexible/index.htm)

ZenOn V6.2 (http://www.copadata.at/de/ger/home.html)
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